Four Creeks Unincorporated Area Council


FCUAC Election Procedures
Voter Mailing List

Overview
FCUAC requests a file of registered voters by providing a list of the UAC precincts to KC Elections.  KC Elections uses the precinct list to select voter registration records.

The data provided by KC Elections is a text (.txt) file with fields separated by commas.

FCUAC provides one ballot mailing per household (address) so the list needs to be edited.  (For mail ballot elections)
A “preliminary” version is requested as soon after KC Elections finalizes any precinct changes (June 1 in 2009).  The preliminary version is used to:

· Count voters in the UAC, the districts, and precincts to help the decision whether to re-apportion the UAC districts

· Test the process for ordering and data analysis to reduce the possibility of errors when the final version is ordered

A “final” version is requested in September-October as soon as the final voter list is available (check with KC Elections on the date).  This version is used to produce:

· The mailing list used for sending ballots
· The registered voter list used to validate ballots

File versions

Multiple versions of the file are created during the process.  They’re described as each are created and used.  A summary is included at the end of the document.
Receive Voters List (File Version 1:OriginalPlus)
Covert text (.txt) file to Excel

The .txt file is opened from within Excel (comma delimited) and then saved as an Excel file (version 1:OriginalPlus).
Record the number of entries

In 2011 the file contained 13,579 records.

In 2009 the file contained 13,484 records.

In 2006 the file contained 14,184 records.

This number is recorded as information for FCUAC and reported by the FCUAC Election Committee.
Record the number of voters per precinct

The data is sorted by precinct and the voters in each precinct are counted.  These counts are recorded as information for FCUAC and reported by the FCUAC Election Committee.

The precinct voter counts are used to update the table of FCUAC districts and precincts and, if needed, used in the following year for re-apportioning the districts.

Do some housekeeping

House fractions

Be careful of house_fraction which can convert to a date format when first opened in Excel.  It may be necessary to change the house_fraction column to a fraction number format and manually transcribe the proper entry into the cells.  Regardless, a visual check of the column and the results in the concatenated registration address is prudent.
 [There are only a very few records with fractions in recent files.]
Format zip code fields

When converting from a text file to an Excel file the number formatting of some fields can be important.  For example, zip codes can start with a “0” which will not usually be displayed.  By selecting the zip code fields and setting a customer format of “00000” will ensure the first digit is displayed.

Format voter id field

[This field is not used so this step is only for completeness.]

To resolve leading zero issues format the voter id field “000000000”.
Add data to help with the edit
[This is only necessary for a mail ballot election where one ballot is being sent to an address]

The objective is to produce a version of the list that has only one record per registered address and mailing address combination.  This isn’t just a matter of deleting records with the same registered voter address although the majority of the edit results from that process.

What complicates matters is there may be more than one registered voter at a registration address with different mailing addresses.  This can occur for a variety of reasons:

· Prefer ballot be mailed to a business address, PO box, private mail box, etc.

· Away at school, military assignment, etc.

· The mailing address is simply different because of the text chosen (e.g. PO Box 12 vs. P.O. Box 12)

In 2006, these situations occurred around 500 times (~3%).

Define field names

To make formulas more readable, some of the data columns are “named”.  These names are used in the formulas instead of Excel cell references (e.g. Y351).

To add the names, an entire column is selected (click on the column letter) and then the column name is inserted (Insert>Name>Define).  (In Excel 10, use the Name Manager on the Formulas tab). The named columns are:
· house_number

· house_fraction

· pre_dir

· street

· type

· post_dir
· building_number

· apartment_number

· bldg_apt (after being added below)

· fraction (after being added below)
Concatenate the registration address

The spreadsheet that comes from KC Elections breaks down the registration address into its components and stores those components in separate columns.  The components include house number, house fraction, pre-dir, street, type, post-dir, building_number, and apartment_number.

Because the registration address is a primary sort, it’s necessary to concatenate the registration address components into their final form.  This is done by adding fields with formulas to perform this concatenation.

Concatenation Formula (building and apartment)

[Discuss with KC Elections to clarify the logic for these two fields.]
The spreadsheet includes building_number and apartment_number.

To keep the final concatenation formula from becoming overly complex, the part of the formula that concatenates building_number and/or apartment_number is performed in this field and then the results are concatenated in the final formula.

=IF(AND(building_number="",apartment_number=""),"",
CONCATENATE("",IF(building_number="",apartment_number,IF(apartment_number="",building_number,
CONCATENATE(building_number," ",apartment_number)))))

When copying this formula to the spreadsheet it will be pasted in separate cells that need to be put into 1 cell.  It can be easier if the equal sigh (=) is removed from the formula until the concatenation is completed.

If the building_number AND the apartment_number are both null, the result of the formula is null.  Otherwise, a blank is added to the concatenation.  The next test is whether the building_number is null in which case the apartment_number is added.  If the apartment_number is null the building_number is added.  If the tests are still false, it means both the building_number and the apartment_number have data so both are added separated by a blank.

Name the field “bldg_apt”.

Concatenation Formula (house_fraction)

Some addresses include a fraction (e.g. 13904 1/2).

To keep the final concatenation formula from becoming overly complex, the part of the formula that concatenates the house fraction is performed in this field and then the results are concatenated in the final formula.

=IF(house_fraction="","",CONCATENATE(TEXT(house_fraction,"?/?")," "))
If the house_fraction is null, the result of the formula is null.  Otherwise, a text version of the house_fraction is concatenated with a blank.  The “?/?” is a number format used for simple fractions.

Name the field “fraction”.

[House_fraction can get converted to a date format when first opened in Excel.  To avoid this it may be best to manually set the number format of the column to a fraction and manually type in the fraction.  Regardless, a visual check of the column and the results in the concatenated registration address is prudent.]

Concatenation Formula (concatenate_reg_address)
Add a field with the name concatenate_reg_address

=IF(pre_dir="",CONCATENATE(house_number," ",fraction,street," ",type," ",post_dir," ",bldg_apt),CONCATENATE(house_number," ",fraction,pre_dir," ",street," ",type," ",bldg_apt))

An address can start off with the direction (e.g. SE 133rd) or end with a direction (e.g. 133rd SE) so the first part of the formula is a test (IF) the pre_dir is null (meaning the direction follows the street).

· If pre-dir is null, the address will have the direction after the street so the concatenation is house_number,blank, house_number, blank,street, blank, type, blank, post-dir, " ",building_number, " "apartment_number).

· If pre-dir is NOT null, the address will have the direction before the street (i.e. concatenate house_number, blank, house_number, blank, pre-dir, street, blank, type, " ",building_number, " "apartment_number).

Remember, the mailing address, not the registration address, is used for mailing so the concatenated registration address is used only for sorting and to compare registration addresses.

Add fields that compare addresses

[This section can be skipped if the election is not a mail ballot one.  However, its recommended that it be added to check on address differences that are simple typos]
Next, fields are added with formulas that find when the addresses change from record to record.  Knowing when addresses change in a sorted file helps identify where decisions about including or excluding a voter record need to be made.

Mark registration address changes (reg_addr_compare)
=IF(previous record concatenate_reg_address=concatenate_reg_address,"","x")

The formula is actually written with relative references:

=IF(AZ1=AZ2,””,”x”)  The column numbers need to be adjusted to point to the concatenate_reg_address column.

This formula compares the concatenated registration address of the current record with that of the previous record.  If they're the same, the cell remains null.  If they're different the cell will contain an “x”.

Mark mailing address changes (mail_addr_compare)
=IF(previous record mail_address= mail_address,"","x")

The formula is actually written with relative references:

=IF(AZ1=AZ2,””,”x”)  The column numbers need to be adjusted to point to the mail_address column.

This formula compares the mailing address of the current record with the mailing address of the previous record.  If they're the same, the cell remains null.  If they're different, the cell will contain an "x".

Compare these last two fields (reg_vs_mail)
The next field to be added compares these last two fields to see if they’re the same (whether null or marked with an “x”).  This field is the focus of the analysis.

=IF(concatenate_reg_compare=mail_street_compare,"","x")

The formula is actually written with relative references:

=IF(AY1=AZ1,””,”x”)  The column numbers need to be adjusted to point to the reg_addr_compare and the mail_addr_compare columns.

Add a fields to store analysis (analysis) and notes (notes)
The final fields are added to contain results from the analysis and miscellaneous notes.  The data put in these fields:

· Helps during the editing work

· Leaves a trail of decisions made if needed for review.

Save the file
Create version for all edits (2:Edit)

Create a copy of 1OriginalPlus
To maintain the integrity of the original data, a copy of the original Excel file with the added edit fields is created (2:Edit).  This file (2:Edit) is where any data changes are made to individual voter records and where Notes are added and changes to field content, if needed, are made.

No records are deleted from 2:Edit.
Sort the data

Sort the entire spreadsheet by registration address and then by mailing address:

· Sort By concatenate_reg_address Then By mail_street.

Analyze using the added fields

Using the added fields the work to edit that data can begin.

The logic

The registration address and the mailing address for a record are compared to the same fields in the previous record:

· Situation 1: If the registration address AND the mailing address are BOTH different, the record is kept.

· Situation 2: If the registration address AND the mailing address are BOTH the same, the record is deleted.

· Situation 3: If the registration address is the same AND the mailing address changes OR the mailing address is the same AND the registration address changes the record is usually kept but further analysis is needed before a final decision is made.
For reference, in the 2006 data all but 399 records were either situation 1 or situation 2.  Of the 399:

· 348 we judged OK (“OK”) during the analysis and the record was kept.

· 41 were transcription differences (“ERR”) in the mailing address that, when corrected were re-compared and either kept or deleted.

· 9 records required further analysis (“?”).
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Situation 1 and Situation 2 examples
This is a sample of the marked up data (the yellow highlights were added just for emphasis).  Every time the concatenate_reg_address changes an “x” shows up in the reg_addr_compare field and every time the mail_street changes an “x” shows up in the mail_addr_compare field.

Since the reg_addr_change and the mail_addr_change are the same for each record (either they both changed or neither changed) the reg_vs_mail field is null for all the sample data.  All of these records are either situation 1 or situation 2 and therefore will be kept or deleted appropriately.
Do NOT do the deletes yet.

Situation 3 examples

Mail_street typing differences
In this example, the mail_street addresses are different only because of the way they were transcribed into the data.  This could occur because the mailing information sent in by one registered voter is slightly different from that sent in from another registered voter or could simply be caused by transcription differences.
In all these cases, “ERR” is entered in the Note field.
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At this point, one of the records is changed so the mail_street addresses are the same.  This will change the result of the mail_addr_compare formula and, like the Situation 1 and Situation 2 example, the second record will be able to be deleted for the final mailing.

Make the mail_street change but do NOT do the delete yet.
[A situation was found in the 2006 data where the mailing address was the same and the registration address was different although it’s not clear why this would occur.]

Other Situation 3 examples
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Record 12283 is an example of where the mail_street address changed and is judged to be OK (the record would be selected).  This also contains another example of where the mail_street change was typographical and would be corrected.  12270 and 12271 appear to be the same mailing address so the correction would be to replace one mail_street with the other.  A note is made in the Note column to log the change.
Remember to re-sort the data after each change to validate that the indicators produced by the formulas have also changed.
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This is an unusual example and the only time in the 2006 data where the registration_address changed but the mail_street stayed the same.  The registration addresses are suspiciously similar.  If this were to occur in current data it might be reported to KC Elections.  The UAC would probably send one ballot to the PO Box.
[Should the UAC include the registration address in the mailing address when there is a different mail_street address?]

Prepare mailing list (3:Mailing)
Save the file and create a new version
At this point, the file is saved and creating a new version (3:Mailing) is created.
Replace formulas with their results

With the formulas comparing the content of neighboring records, any deletions from this point forward could cause the formulas to produce different results.  Therefore, replacing the formulas with their results is the next step.

The way to do that is to select the columns with the added formulas (and the Analysis and Note columns), copy them, and then do an Edit>Paste Special>Values over the top of those same columns.
From this point on, records can be deleted without affecting the formula data.
Note that the file size will significantly reduce by replacing the formulas.

Mailing list

4:Mailing will become the mailing list sent to the printer/mailer.  After deleting data unnecessary the remaining information is analyzed.

Rows

At this point multiple voters at the registration address/mailing address combinations can be deleted.

The easiest way to do this is to sort the file.  Sort By is the reg_addr_compare and Then By mail_addr_compare.  All the records with null in both fields can be deleted.  In 2006 this was 7,297 records(51%).  In 2009 this was 6,937 records (51%).
This is also a good time to make sure there is an entry in the analysis field for all entries where there is a change to the mailing or registration address.

Remove foreign mailings

There are a few records with out of state or out of county mailing addresses.  In 2006, the Election Committee decided not to send ballots to those mailing addresses that would require additional postage.  This meant that all voters with mailing addresses outside the U.S. were not sent ballots.
Note that, according to the USPS web site, military “states” include AA, AE, and AP.  There were 16 such addresses in the 2006 mailing file.  Additionally, there were 20 records out of country.  Finally, there were 87 out of state but still in the U.S.
The policy of the UAC is not to mail to addresses where there will be additional postage.  Therefore all non-U.S. addresses are removed.  This was 22 entries in 2009.

Columns

When preparing for mailing much of the data in the columns is not needed including all the information about the voter (FCUAC uses the generic first line on the mailing “to all registered voters”.  [Given that about 357 voters in 2006 had a mailing address change only, FCUAC needs to review that first line.]
The registration address data is also not needed since the mailing data will be used.  The record layout below shows which columns to keep.

name,care_of,mail_street,mail_city,mail_zip

The “name” column is a re-titling of one of the existing name columns.  Enter the words “Register voters at:” in the name column in every record.

There are 6.526 remaining addresses in 2009.

Produce the Voter List (4:Voters)
Make one additional file copy (4:Voters)

Make another copy of 2:Edit (4:Voters).

4:Voters will become the registered voter list used when votes are validated.  Since only the voters name and the registration address are needed, the rest of the data in the columns can be deleted.

Once again, copy>paste special>values all the added fields.

Create a new full name field

=CONCATENATE(A2,", ",B2," ",C2," ",D2)
Keep the concatenated name information, the voting precinct, and the concatenated registration address along with city, state and zip
Voter List Fields (2006, 2009)
	Field
	Description
	Keep in final file

	voter_id
	
	

	status (A, I, P)
	Active (A), Inactive (I), Pending (P)  Pending: Basically, they can still vote but Elections has to verify something; usually their ID or address.
	

	name_last
	
	

	name_first
	
	

	name_middle
	
	

	name_suffix
	
	

	house_number
	
	

	house_fraction
	e.g. 1/2, 1/3
	

	pre_dir
	Contains the address direction (NE, SE, etc.) if it proceeds the street address.  Mutually exclusive with post_dir.
	

	street
	
	

	type
	e.g. Ave, Blvd, Ct, Dr, Ln, Pl, Rd, St, Way
	

	post_dir
	Contains the address direction (NE, SE, etc.) if it follows the street address.  Mutually exclusive with pre_dir.
	

	building_number
	
	

	apartment_number
	
	

	city
	
	

	state
	
	

	zip
	
	

	precinct
	
	

	portion
	
	

	reg_date
	
	

	gender
	M/F
	

	PAV
	Permanent Absentee Voter  Y/N
	

	birth_date
	m/d/yyyy
	

	care_of
	
	Yes

	mail_street
	
	Yes

	mail_city
	
	Yes

	mail_state
	
	Yes

	mail_zip
	
	Yes

	mail_country
	
	Yes

	precinct_name
	
	

	various voting histories (in 2009 a number of voting histories, unnecessary for FCUAC, were included in the data)
	Voting credits:
A = absentee
N = not voted
N(NP) = Not voted (non-partisan) Polls
V = Voted (polls)
V(NP) = Voted (non-partisan: Polls)
Blank = Not eligible
	


File versions

	Version
	2006 Name
	Purpose

	1:OriginalPlus
	FCUAC yymmdd Voters_1OriginalPlus.xls
	Original (stored in Excel) for reference.  The only change are fields (columns) added containing formulas useful in analyzing the voter data.

	2:Edit
	FCUAC yyddmm Voters_2Edit.xls
	A copy of 1:OriginalPlus where edits are made primarily to the mailing addresses with minor transcription anomalies.

	3:Mailing
	FCUAC yyddmm Voters_3Mailing.xls
	A copy of 2:Edit with the added formulas replaced by the formula results.  Unnecessary data is deleted the result of which is a list of all mailing locations.  Used during ballot printing/mailing.

	4:Voters
	FCUAC yyddmm Voters_4Voters.xls
	A copy of 2:Edit with the added formulas replaced by the formula results.  Unnecessary data is deleted the result of which is a list of all voters and their registration addresses.  Used during vote counting to validate the ballot source.
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